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ABSTRACT 

The detection and maintenance of underground water channels, particularly for water flow monitoring and 

pipeline repairs, are critical for efficient urban water management. This project proposes an Arduino UNO 

based robot equipped with Doppler radar to detect water flow within underground water pipes. The robot's 

movement is controlled remotely using a Bluetooth interface, and the detected data is transmitted to a mobile 

app in real-time. In addition to water detection, a buzzer is activated to alert the operator when significant 

water flow is detected. The robot's mobility is achieved through DC motors, allowing for precise control of its 

movement via a mobile app. This system aims to provide an efficient, real-time solution for underground water 

pipe inspection and repair, minimizing disruption and improving water management operations. 

 

Keywords – Arduino UNO, Motor Driver, Water channel inspection, Doppler Radar. 

 

I. INTRODUCTION 

        Water is a foundational element of urban life, and its effective management is critical for the health, 

safety, and prosperity of any society. Underground water pipelines form an indispensable component of 

modern urban infrastructure, responsible for the seamless transportation of potable water, removal of 

wastewater, and distribution of industrial fluids. These extensive pipeline networks lie buried beneath cities, 

operating out of sight but playing a vital role in sustaining everyday life. As cities continue to expand, with 

increasing populations and urban density, the demand on existing water infrastructure grows exponentially. 

This puts additional stress on pipeline systems, which, in many cases, are already decades old and prone to 

deterioration. Over time, underground pipelines are exposed to a wide range of stressors, including pressure 

surges, temperature changes, corrosion, shifting soil conditions, and external physical disturbances. These 

factors can lead to a variety of faults, such as cracks, joint failures, sediment buildup, and complete blockages. 

Leaks, in particular, can result in substantial water losses—some estimates suggest that urban water systems 

can lose as much as 30% of their supply due to undetected leaks. Such issues not only affect the efficiency and 

reliability of water delivery but also increase the risk of contamination, damage to surrounding infrastructure, 

and escalating maintenance costs. 

Traditional methods for detecting faults in underground pipelines typically involve invasive and manual 

procedures, such as excavation, insertion of tethered inspection tools, or deployment of ground-penetrating 

radar systems. While these methods can be effective, they are often time-consuming, expensive, and disruptive 
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to local communities. Road closures, traffic diversions, and service interruptions are common side effects of 

pipeline inspection and repair. Moreover, these techniques do not always provide real-time data or early 

detection capabilities, which are essential for preventive maintenance. 

In recent years, the rise of embedded systems, smart sensors, wireless communication technologies, and mobile 

applications has paved the way for new approaches to infrastructure monitoring. These advancements enable 

the development of compact, autonomous, and remote-controlled robotic systems capable of accessing 

confined spaces and collecting valuable data without causing surface disruption. One particularly promising 

technology in this regard is the use of Doppler radar sensors, which are capable of detecting fluid flow based 

on frequency shifts in reflected signals. When integrated into a mobile robotic platform, such sensors can 

provide real-time flow detection, aiding in the identification of leaks, blockages, or irregular water movement 

within underground pipelines. This project seeks to harness the power of these emerging technologies by 

designing and implementing a robotic system based on the Arduino UNO microcontroller platform. The robot 

will be equipped with a Doppler radar sensor to detect water flow in underground pipes and will be controlled 

wirelessly through a Bluetooth-enabled mobile application. The system is designed to be compact and 

maneuverable, suitable for navigating narrow pipeline interiors while collecting and transmitting data in real-

time. An integrated auditory alert system, activated upon flow detection, will provide immediate feedback to 

operators, enabling fast localization of potential faults. 

Ultimately, this project addresses a critical need in urban infrastructure by combining embedded systems, 

robotics, and mobile technology to enhance the monitoring and maintenance of underground water networks. 

The success of this system can serve as a model for future innovations in smart infrastructure and contribute 

meaningfully to the global pursuit of sustainable urban development. 

II    LITERATURE REVIEW 

 

 The first paper, Chen, Meize, Guangze Cao, and Jianing Yang. "Remote System Design of Urban 

Underground Comprehensive Pipe Gallery Inspection." Proceedings of the 2023 IEEE 6th Eurasian Conference 

on Educational Innovation (ECEI), 2023. 

Observation: The paper by Meize Chen, Guangze Cao, and Jianing Yang, presents the transmission              

characteristics of ultrasonic signals in water-filled pipes. It explores how various factors like pipe material, 

diameter, and water flow affect signal attenuation and propagation. The study concludes that ultrasonic signal 

strength is influenced by the pipe’s physical parameters and the medium inside, impacting its effective- ness for 

inspection and monitoring applications. 

 

 The second paper, Kazeminasab, S., N. Sadeghi, V. Janfaza, M. Razavi, S. Ziyadidegan, and M. K. 

Banks. "Localization, Mapping, Navigation, and Inspection Methods in In-Pipe Robots: A Review." IEEE 

Access, vol. 9, 2021, pp. 162035-162058. DOI: 10.1109/ACCESS.2021.3130233.  

Observation: The paper by S. Kazeminasab et al. (2021) reviews various techniques for localization, mapping, 

navigation, and inspection used in in-pipe robots. It examines the strengths and limitations of different methods, 

including sensor-based approaches, control algorithms, and mapping techniques. The study highlights 

advancements and challenges in achieving accurate and efficient navigation for robotic inspection within 

complex pipe networks. 

 

 The third paper, [3]Pourbosseini, H., F. Zahedi, and J. Majrouhi Sardroud. "Robot BIM Integration 

for Underground     Canals Life Cycle Management." Taylor & Francis Group, 2023. 

Observation: The paper by H. Pourhosseini, F. Zahedi, J. Majrouhi Sardroud presents the integration of robotic 
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systems with Building Information Modeling (BIM) for the comprehensive management of underground surface 

water collection canals. The study presents a robotic innovation that utilizes various technologies to monitor and 

assess canal health in environments containing flammable gases and moisture.  

 

 [4] Khelif, Raouia, et al. "A Multiwire-Based Technique for Leak Detection and Localization in 

Underground Water Pipelines." Proceedings of the 2020 International Conference on Emerging Smart 

Technologies and Applications (eSmarTA), 2020. 

Observation: The leak problem in water distribution systems has attracted the attention of many researchers 

during the past few decades. Water losses through leakages represent an issue that has negative impacts on the 

environmental and economic systems. Detecting and locating the source of leakage in the water distribution 

network can significantly reduce the amount of water lost and prevent the destruction of the infrastructure due to 

water leakage. In this paper, several methods for water leak detection are presented while indicating their 

advantages and drawbacks. In addition, a new technique based on using multiple sensing wires with different 

lengths is proposed. This solution consists in detecting and locating water leak by measuring the variations in 

soil moisture. The experiments made are presented to prove the simplicity, ease of use and the ability of the 

proposed technique to detect and pinpoint the location of water leak in underground pipelines. 

 

III      SYSTEM ARCHITECTURE & IMPLEMENTATION 

1. ARDUINO IDE 

 

 

Figure 1: Arduino IDE 

It is an Arduino software, also known asthe Arduino Integrated Development Environment (IDE), is a platform 

used for writing and uploading code to Arduino-compatible boards. It includes a text editor for writing code, 

a message area, a text console, a toolbar with buttons for common functions, and a series of menus. It connects 

to the Arduino hardware via a USB cable and communicates using a simple protocol. The Arduino IDE 

supports programming in C/C++ and provides a standard API called "Arduino language ," simplifying the 

programming process. Users write code in the IDE, which is then compiled and uploaded to the Arduino board. 

The board executes the uploaded code, which can interact with sensors, motors, and other electronic 

components to create a wide range of projects, from simple LED blinking to complex robotics. The IDE's 

simplicity and the extensive online community make it accessible for beginners and powerful 

for advanced users. 
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Procedure 

1. Connect Your Arduino 

Plug your Arduino board into your computer via USB. 

Wait for your computer to detect it (drivers may install automatically). 

Open Arduino IDE 

Launch the Arduino IDE on your computer. 

2.Select the Board 

Go to Tools > Board and select the correct board (e.g., Arduino Uno, Mega, Nano, etc.). 

4. Select the Port 

Go to Tools > Port and choose the COM port associated with your Arduino (e.g., COM3, COM4, etc.). 

If you’re unsure which one, unplug the Arduino and plug it back in to see which port disappears/reappears. 

5. Open or Paste Your Code 

Either write your code in the editor or paste code into a new sketch window. 

6. Verify the Code 

Click the checkmark icon (top-left) or go to Sketch > Verify/Compile to compile your code and check for 

errors. 

7. Upload the Code 

Click the right-arrow icon (next to the checkmark) or go to Sketch > Upload. 

Wait for the upload to complete (you'll see "Done uploading" at the bottom if successful). 

 

    2.BLUETOOTH SERIAL TERMINAL APP: 

 

                                                                     Figure 2: Bluetooth serial terminal app 

 

The Bluetooth Serial Terminal app is a handy tool for wireless communication with Bluetooth-enabled 

devices.It connects to modules like HC-05 or HC-06 using the Serial Port Profile (SPP).This app is widely 

used by developers working on embedded systems and IoT projects .Users can send and receive serial data in 

real-time from their smartphones .It supports both ASCII and HEX formats for flexible communication. The 

app also offers features like command history, auto-reconnect, and line-ending settings. It's an essential utility 

for testing, debugging, and monitoring Bluetooth serial communication. 
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Procedure: 

1. Install the “Serial Bluetooth Terminal” app from the Google Play Store. 

2. Power on your robot and ensure the Bluetooth module, such as HC-05 or HC-06, is properly connected to 

the microcontroller. 

3. Pair your mobile phone with the Bluetooth module using your phone’s Bluetooth settings. The default PIN 

is usually 1234 or 0000. 

4. Open the Bluetooth Serial Terminal app, go to the devices section, and connect to your Bluetooth module. 

5. Once connected, use the terminal screen to send single-character commands to control the robot: 

M1  to move forward 

M2  to move backward 

M3  to turn left 

M4  to turn right 

M5  to stop 

M6 radar turn on  

M7 radar turn off 

6. For easier control, go to the “Keyboard” tab in the app and create custom buttons for each command so you 

can control the robot with one tap. 

7. If a radar sensor is connected and programmed to send messages through Bluetooth, the app will display 

feedback like “Movement Detected” in the terminal when the sensor is triggered. 

 

IV  BLOCK DIAGRAM 

                                                                                

                                                                                   Figure 3: Block diagram 

The above Fig.3 illustrates the Block Diagram of the proposed system, which comprises key components 

including the Arduino UNO microcontroller, Bluetooth communication module, Doppler radar unit, motor 

control unit, and a dedicated power supply. This block diagram represents the overall architecture of a robotic 

system designed specifically for the detection, monitoring, and maintenance of underground water channels 

and pipelines. At the heart of the system is the Arduino UNO, which serves as the main control unit, 
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coordinating the operations of all peripheral components. A Doppler radar sensor is integrated into the robot 

to detect the presence and flow rate of water within pipes. This radar technology enables non-intrusive 

monitoring by measuring the velocity of moving water molecules, which provides reliable and accurate flow 

data. For mobility, the robot is equipped with DC motors that allow it to navigate through pipeline structures. 

These motors are controlled via a motor driver circuit connected to the Arduino, enabling precise movement 

and direction control. The robot can be remotely operated using a Bluetooth module, which establishes a 

wireless link between the robot and a mobile application. This app not only allows users to control the 

movement of the robot but also to monitor real-time data transmitted from the Doppler radar sensor. To 

enhance safety and user awareness, a buzzer alert system is included. When the radar detects significant or 

abnormal water flow—indicative of potential pipe damage, leakage, or high-pressure conditions—the buzzer 

is triggered to notify the operator immediately. This feature ensures that critical issues are not overlooked 

during inspection routines. The entire system is powered by a stable DC power supply, ensuring uninterrupted 

operation of all components during field use. The robot's compact and rugged design makes it suitable for 

maneuvering through confined underground pipelines while maintaining consistent communication and data 

reporting. 

 

 

V   FLOWCHART 

                                                                   Figure 4: Flow chart 

 

The above Fig.4 illustrates the flow chart of the Underground Water Channel Robot, outlining the sequential 

operations carried out by the system. The process begins with the initialization of the power supply, ensuring 

that all hardware components are properly energized. Following this, the system attempts to activate the 

Bluetooth module, which is essential for establishing wireless communication with a mobile device. If the 

activation fails, the system continuously retries the connection until it succeeds. Once Bluetooth connectivity 
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is established, the radar unit is initialized to begin inspecting the underground environment. The core 

functionality of the robot lies in its ability to detect underground water channels using a Doppler radar sensor. 

During inspection, if no water channel is detected, the system remains in monitoring mode, continuously 

scanning the area. However, when a channel is detected, the robot proceeds to collect and process the relevant 

data. This processed data, which includes information about water flow, is then transmitted to a connected 

mobile application via Bluetooth. To ensure reliable communication, the system verifies the success of the 

data transmission. If the data is successfully transmitted, the operation ends. In cases where the transmission 

fails, the system retries sending the data until it is successful. This flow chart highlights the robot's capability 

for continuous monitoring, real-time data processing. 

 

VI  HARDWARE REQUIREMENTS 

 

The Hardware components required for underground water channel Robot are: 

1. Arduino UNO 2. Digital 10.525 GHz Microwave Sensor 3. Bluetooth module (HC-05) 4. DC motors 5. 

Motor driver (L298N) 6. Chassis or Robotic Platform 7. Wheels and Mounting Components 8. Wires and 

connectors 9. Buzzer 10. Power supply 11. Mobile Device (with Bluetooth capability). 

        1.ARDUINO UNO: 

                                                                        Figure 5: Arduino UNO 

     It is a popular open-source microcontroller board based on the ATmega328P microcontroller. It is widely 

used in embedded systems and robotics projects due to its simplicity, reliability, and ease of programming. 

The board provides a user-friendly platform for interfacing sensors, actuators, and communication modules, 

making it ideal for 

real-time monitoring and control applications. 

 

       2.DIGITAL 10.525 GHZ MICROWAVE SENSOR(RADAR) 

 

Figure 6: Digital 10.525 GHz microwave sensor(radar) 
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The Digital 10.525 GHz Microwave Sensor is a motion detection sensor that operates using Doppler radar 

technology. It emits continuous microwave signals at a frequency of 10.525 GHz and detects changes in the 

reflected signals caused by moving objects, such as flowing water or mechanical movement, based on the 

Doppler effect. This sensor can detect motion through non-metallic materials such as plastic, wood, or glass. 

 

3. HC-05 BLUETOOTH MODULE 

Figure 7: HC-05   Bluetooth Module 

 

The HC-05 Bluetooth module is a low-cost, easy-to-use wireless serial communication device designed for 

short-range data exchange between microcontrollers and Bluetooth-enabled devices such as smartphones or 

tablets. It operates over Bluetooth 2.0 protocol and is commonly used in embedded systems, robotics, and 

DIY electronics for wireless control and monitoring. 

 

4. 100 RPM BO MOTOR 

                                                                       Figure 8: 100 rpm BO motor 

A 100 RPM BO motor is a specific type of DC motor with built-in gearing for low-speed, high-torque output. 

The 100 RPM BO (Battery Operated) Motor is a compact, low-speed geared DC motor commonly used in 

hobby robotics and small automation projects. Designed for easy integration with wheels and chassis, it 

provides moderate speed with high torque, making it ideal for applications where controlled movement is 

essential. 
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       5. L298N MOTOR DRIVER 

Figure 9: L298N motor driver 

The L298N is a versatile dual H-Bridge motor driver IC used for controlling the speed and direction of DC 

motors, stepper motors, and other types of motors. It is designed to work with a wide range of voltages and 

can control two motors simultaneously, making it ideal for robotics, automation, and other projects that require 

motor control.  

 

        6. CHASSIS OR ROBOTIC PLATFORM: 

 

Figure 10: Chassis 

 

A robot chassis is the structural frame that holds and supports all components of a robot, such as motors, 

wheels sensors, and electronics. It provides stability, allows movement, and forms the base for building 

robotic systems. 

 

       7.WHEELS  

 

Figure 11: Wheels 

 

Wheels and mounting components are essential parts of a mobile robot, enabling smooth movement and 

secure attachment of motors and other parts. Wheels provide traction, while mounting accessories connect 
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motors, chassis, and sensors. 

 

 

8. PIEZO BUZZER 

 

 

Figure 12: Piezo Buzzer 

A piezo buzzer is an electronic sound-producing device that generates audio signals using piezoelectric 

vibration. It's compact, energy-efficient, and ideal for alert or notification systems in electronic and robotic 

projects. 

 

       9. BATTERY 

 

Figure 13: Lithium-ion Battery 

 

Lithium-ion batteries (Li-ion) are rechargeable batteries that are widely utilized in portable electronics and 

electric vehicles. Li-ion batteries have various advantages over other types of rechargeable batteries, including 

high energy density, a low self-discharge rate, and no memory effect (they do not need to be entirely depleted 

before recharging). Li-ion batteries require specific charging algorithms to ensure safe and efficient operation. 

Overcharging can shorten battery life and even pose safety risks, hence most Li-ion batteries include built-in 

protective circuits to prevent overcharging and over discharge. 

 

VII  METHODOLOGY 

 

The methodology of this project involves a combination of hardware components, software programming, and 

communication protocols to achieve real-time detection and reporting of water flow in underground channels. 

 

1. Hardware Implementation:  

- Arduino UNO Microcontroller: The heart of the system, responsible for controlling the robot’s movements 

and interfacing with the Doppler radar sensor, Bluetooth module, motors, and buzzer. 

 - Doppler Radar Sensor: This sensor is used to detect the presence of water flow in underground pipes by 

measuring the changes in the frequency of waves that reflect off moving water particles. 
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 - DC Motors and Motor Driver: The robot is equipped with motors that allow it to navigate through 

underground spaces or around pipe channels. These motors are controlled via a motor driver connected to the 

Arduino UNO, with inputs from the Bluetooth controller. 

 - Bluetooth Module: This module allows for wireless communication between the robot and the mobile app, 

enabling remote control of the robot’s movement and data transmission of the detected water flow to the user’s 

mobile device. - Buzzer: The buzzer is programmed to sound when water flow is detected by the Doppler 

radar, providing an auditory alert to the user. 

2. Software Development:  

- The system's software is developed using the Arduino IDE, with appropriate libraries for controlling the 

motors, Bluetooth module, and radar sensor. 

 - Bluetooth Communication: A mobile application is designed to interface with the robot via Bluetooth, 

providing a user-friendly interface for controlling the robot’s movement (forward, backward, left, and right). 

The app also displays real-time data on water flow as detected by the radar.  

- Data Processing and Alerts: The Doppler radar sensor continuously sends data to the Arduino UNO, which 

processes this information to detect any anomalies or water flow in the pipes. When water flow is detected, 

the system triggers the buzzer and transmits the data to the mobile app for display. 

3. Robot Movement and Control: 

 - The user can control the robot’s movement using the mobile app, which sends commands via Bluetooth to 

the Arduino UNO. The Arduino UNO then sends signals to the motor driver, which moves the motors 

according to the user’s inputs, allowing for full directional control of the robot. 

 

4. Data Transmission and Notification: 

 - The Doppler radar’s data is transmitted wirelessly to the mobile app via Bluetooth. The app processes the 

data in real-time, displaying whether water flow is present and the approximate strength of the flow. If water 

flow is detected, the app can log the data for further analysis.  

- An additional feature includes triggering the buzzer when water flow is detected, providing an immediate 

auditory signal to the user in the field.  

 

 

5. Testing and Calibration: 

 - The system undergoes testing in various underground water pipe scenarios to ensure accurate detection of 

water flow. Calibration of the Doppler radar is done to fine-tune the sensitivity and accuracy of water flow 

measurements. 
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          Figure 14: Circuit Connection                   Figure 15: Mobile device with Bluetooth serial terminal app 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 16: Final  model 
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VIII CONCLUSION 

 

The Arduino UNO-based underground water channel detection robot exemplifies the practical application of 

embedded systems and sensor technology in solving real-world infrastructure challenges. Its integration of 

Doppler radar for non-invasive water flow detection, combined with Bluetooth-enabled mobility and real-time 

data feedback, provides a cost-effective and user friendly approach to underground pipeline monitoring. The 

system’s ability to deliver instant alerts via a buzzer and mobile interface ensures rapid response to flow 

anomalies, helping to prevent major leaks, blockages, or potential failures.  

 

This innovation significantly reduces the need for disruptive and expensive excavation work, while enhancing 

the efficiency and accuracy of water infrastructure assessments. As urban populations increase and the demand 

for smart resource management grows, such robotic systems stand as a testament to how low-cost automation 

and sensor fusion can transform conventional maintenance practices. Moving forward, this robot not only 

serves as a valuable tool for municipal and industrial pipeline inspection but also lays the groundwork for 

future advancements in smart city infrastructure and sustainable water management technologies.  
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